
Jak wyświetlid kilka modelek w pełnym 
rozmiarze na jednym ekranie? 
(dla użytkowników systemu Windows) 

 

iStripper może działad w dwóch głównych trybach: desktopowym oraz wygaszacza ekranu. Pierwszy z nich 

to tryb, w którym modelki wyświetlane są na pulpicie twojego komputera podczas gdy ty wykonujesz 

standardowe czynności związane np. z pracą, rozrywką, surfowaniem po Internecie itp. Drugi tryb, 

wygaszacz ekranu, uruchamiany może byd po pewnym czasie bezczynności. Wszystkie okna aplikacji oraz 

pulpit są wówczas ukrywane, a na ekranie pojawia się wybrana w ustawieniach tzw. scena. Niniejszy artykuł 

poświęcony jest pierwszemu z wymienionych trybów - trybowi desktopowemu. 

Pracując w trybie desktopowym użytkownik ma do wyboru: 

 wyświetlanie modelek w maksymalnym rozmiarze (60%-200% rozmiaru monitora) lub 

 wyświetlanie modelek w pomniejszonym rozmiarze (10%-60% rozmiaru monitora). 

Każda z tych opcji posiada pewne ograniczenia. Podczas wyświetlania modelki w pełnym rozmiarze możliwe 

jest odtwarzanie tylko jednego pokazu. Nie możesz wyświetlid dwóch modelek w pełnym rozmiarze. 

Ponadto nie możesz zmienid pozycji klipu poprzez przeciąganie i upuszczanie modelki. Wyświetlanie 

modelek w pomniejszonym rozmiarze pozwala natomiast na odtwarzanie aż dziesięciu pokazów na raz, 

jednakże tutaj ograniczeniem jest rozmiar klipów. Nie możesz ustawid ich skali powyżej 60% rozmiaru 

twojego monitora. 

Wyobraź sobie teraz jakby wyglądał twój pulpit gdyby taoczyła na nim nie jedna, lecz przynajmniej dwie 

modelki jednocześnie, obie w pełnym rozmiarze? Byd może posiadasz w swojej konfiguracji kilka monitorów 

i chciałbyś aby na każdym z nich w tym samym czasie taoczyła pełnowymiarowa dziewczyna? Niestety, 

iStripper nie udostępnia takiej opcji. Na szczęście z pomocą przychodzą aplikacje innych producentów. 

Nie zostały one co prawda w tym celu stworzone, jednakże z powodzeniem można je tutaj zastosowad. 



W niniejszym artykule przedstawione są aż trzy metody pozwalające na wyświetlenie kilku 

pełnowymiarowych dziewcząt, na jednym lub wielu monitorach, w tym samym czasie. Każda z metod 

wykorzystuje inne oprogramowanie. Artykuł podzielono na trzy sekcje, z których każda poświęcona jest 

osobnej metodzie. W każdej metodzie dokładnie opisano sposób pobrania programu, jego instalację, 

a także obsługę. Każda z metod została przetestowana i działa. Testy wykonano korzystając 

z następującego oprogramowania: 

 system operacyjny Windows 7 (64-bit) 

 iStripper 1.2.190 

 Sandboxie 5.24 (64-bit) 

 Process Explorer 16.21 (64-bit) 

 Cheat Engine 6.7 

UWAGA: Pamiętaj, że decydując się na wykorzystanie którejkolwiek metody bierzesz pełną 

odpowiedzialnośd za wykonywane czynności. Za ewentualne błędy lub nieprawidłowości związane 

z działaniem któregokolwiek z programów, a także systemu Windows, odpowiedzialnośd spoczywa na 

Tobie. Ani autor niniejszego artykułu, ani firma Totem Entertainment nie ponoszą odpowiedzialności 

za efekty podejmowanych przez ciebie działao. 

Wybierz teraz jedną z dostępnych metod, lub zapoznaj się z każdą po kolei i wybierz tą, którą będzie 

ci najbardziej odpowiadad: 

1. Nowy proces w piaskownicy - metoda z użyciem Sandboxie, 

2. Duplikowanie procesów - metoda z użyciem Process Explorer, 

3. Edycja zawartości pamięci RAM - metoda z użyciem Cheat Engine. 

 

  



Nowy proces w piaskownicy - metoda z użyciem 
Sandboxie 

Metoda polega na uruchomieniu programu iStripper w dwóch osobnych procesach (dwóch osobnych 

instancjach). W normalnych warunkach jest to niemożliwe, ponieważ w systemie może działad tylko jeden 

proces iStripper. Próba uruchomienia kolejnej "kopii" programu kooczy się zazwyczaj przywołaniem okna 

tej kopii, która została uruchomiona jako pierwsza. 

Aby móc uruchomid kolejną kopię iStripper wykorzystamy darmową wersję programu Sandboxie. Po jego 

zainstalowaniu możliwe będzie utworzenie tzw. "piaskownicy", czyli kontrolowanego środowiska, w którym 

uruchomiona zostanie druga kopia programu iStripper. Każda aplikacja uruchomiona w takim środowisku 

(w tym również iStripper) nie będzie widziała innych programów, które działają w systemie w normalny 

sposób. Darmowa wersja Sandboxie pozwala na utworzenie tylko jednej piaskownicy, jednakże powinno to 

w wielu wypadkach wystarczyd. 

Pobieranie programu Sandboxie 

Aby pobrad program Sandboxie otwórz dowolną przeglądarkę i przejdź pod adres: 

https://www.sandboxie.com/DownloadSandboxie 

Pobierz program instalacyjny klikając na obrazek z napisem "Sandboxie", zaznaczony na poniższym 

printscreenie. 

 



Zapisz instalator (plik SandboxieInstall.exe) w dowolnym miejscu na dysku twojego komputera. 

Instalacja programu Sandboxie 

Aby zainstalowad program Sandboxie otwórz folder, do którego pobrałeś instalator i kliknij dwukrotnie na 

plik SandboxieInstall.exe. W pierwszym kroku instalacji należy wybrad preferowany język. Wybierz go z listy 

dostępnych języków i kliknij przycisk OK. 

 

Zatwierdź postanowienia licencji klikając przycisk I Agree. 

 

Wybierz ścieżkę do folderu, w którym zostanie zainstalowany Sandboxie. Domyślna ścieżka to: 



C:\Program Files\Sandboxie 

Pozostaw ją bez zmian i kliknij przycisk Install. 

 

Zaczekaj na zakooczenie instalacji, poczym kliknij przycisk Next. 

 



W kolejnym kroku program Sandboxie zechce zainstalowad sterowniki systemowe. Ich instalacja jest 

niezbędna. Bez tych sterowników Sandboxie nie zadziała. Kliknij przycisk Next. 

 

Instalacja sterowników systemowych była ostatnim krokiem w procesie instalacji. Wyjdź z instalatora 

klikając przycisk Finish. 

 



Sandboxie uruchomi się natychmiast po instalacji. Możliwe, że przy pierwszym uruchomieniu program 

będzie chciał zastosowad pliki konfiguracyjne dla niektórych programów znalezionych w twoim systemie. 

Zapyta wówczas o zgodę na ich zastosowanie. Nie jest to konieczne do naszych celów, dlatego w tym 

momencie możesz zamknąd okno klikając X w prawym górnym rogu okienka. 

 

Następnie zostanie wyświetlony krótki samouczek dla osób zaczynających przygodę z Sandboxie. Wskazane 

jest aby przeczytad znajdujące się w nim wskazówki. Po zakooczeniu samouczka kliknij przycisk Done 

lub Close. 

 



Sandboxie już działa. Okienko programu wygląda następująco: 

 

Na chwilę obecną możesz je zamknąd. Nie będziemy wykonywad w nim żadnych konfiguracji, gdyż 

domyślne ustawienia programu w zupełności wystarczą do tego, co chcemy za jego pomocą osiągnąd. 

Zamknięcie okna przyciskiem X w prawym górnym rogu spowoduje zminimalizowanie okna do paska 

systemowego, o czym program poinformuje wyświetlając komunikat. 

 

Główne okno programu zniknie, jednak program nadal będzie działał w tle, co będzie reprezentowane przez 

żółtą ikonkę w pasku systemowym, jak widad poniżej: 

 

Sandboxie jest gotowy. Przejdźmy teraz do uruchomienia iStripper w piaskownicy. 



Obsługa programu Sandboxie 

Sandboxie działa w tle, o czym informuje żółta ikonka w pasku sytemowym. Można już uruchomid iStripper 

w piaskownicy. Pierwszy sposób: kliknij żółtą ikonkę Sandboxie prawym przyciskiem myszy 

i wybierz polecenie: 

DeafultBox > Run From Start Menu  

 

Zobaczysz listę programów zainstalowanych na twoim komputerze. Na dostępnej liście odnajdź: 

Programs > iStripper > iStripper 

i kliknij by uruchomid program iStripper w piaskownicy. Po chwili otworzy się druga kopia programu 

iStripper. Powinieneś zauważyd dodatkową ikonkę iStripper w pasku systemowym. 

 

Drugi sposób: zlokalizuj skrót do programu iStripper (np. w menu Start, lub skrót na pulpicie, jeśli jakiś 

został utworzony), kliknij na nim prawym przyciskiem myszy i wybierz polecenie Run Sandboxed. Pojawi się 

okno, w którym będziesz mógł wybrad piaskownicę. 



 

Wskaż domyślną piaskownicę (DefaultBox) i kliknij przycisk OK. Po chwili zostanie uruchomiona druga kopia 

iStripper. 

Istnieje możliwośd uruchomienia większej liczby piaskownic, a co za tym idzie większej liczby instancji 

(kopii) programu iStripper, jednak aby tego dokonad należy zakupid licencję dla programu Sandboxie. 

Darmowa wersja Sandboxie pozwala na utworzenie tylko jednej piaskownicy. 

Obsługa programu iStripper 

Teraz, gdy masz uruchomione dwie kopie programu iStripper (jedną w trybie normalnym i jedną 

w piaskownicy), możesz kontrolowad każdą z nich osobno. Aktywuj obie kopie iStripper i pobaw się 

ustawieniami w każdym z dwóch interfejsów iStripper (GUI). Możesz ustawid inne opcje w każdej kopii 

programu. Po wyjściu z programu iStripper ustawienia każdej jego kopii zostaną zapamiętane. 

 



W przypadku wielu monitorów, aby wyświetlid po jednej modelce na każdym z nich: kliknij na wybranej 

modelce by przełączyd ją do rozmiaru pomniejszonego, przeciągnij ją na wybrany monitor i upuśd, kliknij na 

niej ponownie by przełączyd do trybu powiększonego. 

Zalety: 

 możesz wyświetlid aż dwadzieścia modelek jednocześnie w trybie pomniejszonym (UWAGA: takie 

ustawienie może znacznie spowolnid twój komputer!), 

 możesz wyświetlid dwie modelki w trybie powiększonym, 

 jeśli posiadasz dwa ekrany, możesz wyświetlid po jednej modelce w trybie powiększonym na 

każdym z ekranów, 

 dla każdej modelki wyświetlanej w trybie powiększonym możesz używad osobnych ustawieo (np. 

inna skala dla każdej z dziewczyn), 

 ustawienia dla każdej kopii programu zostaną zapisane i zachowane nawet po zamknięciu 

wszystkich kopii programu iStripper. 

Wady: 

 nie możesz zmieniad pozycji klipów w trybie powiększonym przez przeciąganie i upuszczanie 

(drag'n'drop). 

  

  



Duplikowanie procesów - metoda z użyciem 

Process Explorer 

Metoda polega na uruchomieniu programu iStripper w wielu osobnych procesach (osobnych instancjach). 

W normalnych warunkach jest to niemożliwe, ponieważ w systemie może działad tylko jeden proces 

iStripper. Próba uruchomienia kolejnej "kopii" programu kooczy się zazwyczaj przywołaniem okna tej kopii, 

która została uruchomiona jako pierwsza. 

Metoda ta jest nieco zbliżona do pierwszej metody (z użyciem piaskownicy), jednakże opisywany tutaj 

sposób pozwala na uruchomienie dowolnej liczby procesów iStripper (więcej niż dwóch). 

Aby uruchomid wiele kopii programu iStripper wykorzystamy darmowe narzędzie o nazwie Process 

Explorer. Narzędzie dostępne jest do pobrania ze stron Microsoftu. Pozwala ono między innymi 

kontrolowad uruchomione procesy oraz monitorowad wykorzystywane przez nie zasoby. 

Pobieranie programu Process Explorer 

Aby pobrad program Process Explorer otwórz dowolną przeglądarkę i przejdź pod adres: 

https://docs.microsoft.com/en-us/sysinternals/downloads/process-explorer 

Pobierz program klikając link "Download Process Explorer", zaznaczony na poniższym printscreenie. 

 



Zapisz plik ProcessExplorer.zip w dowolnym miejscu na dysku twojego komputera. 

Instalacja programu Process Explorer 

Otwórz folder, do którego pobrałeś plik ProcessExplorer.zip i wypakuj zawartośd archiwum do dowolnego 

folderu. Process Explorer tak na prawdę nie wymaga instalacji. Wystarczy po prostu go uruchomid. 

Obsługa programu Process Explorer 

Jeśli iStripper jest wyłączony, włącz go teraz. Jeśli używasz systemu 64-bitowego, wybierz Process Explorer 

w wersji 64-bitowej (procexp64.exe), w przeciwnym razie wybierz wersję 32-bitową (procexp.exe). 

 

Przy pierwszym uruchomieniu zostaniesz poproszony o akceptowanie postanowieo licencyjnych. 

Kliknij Agree. 



 

Zobaczysz główne okno aplikacji. Wyświetlona jest w nim lista wszystkich procesów uruchomionych na 

twoim komputerze. Na liście procesów odnajdź proces o nazwie vghd.exe i zaznacz go. 

 

Pozostawiając zaznaczony proces, wyświetl dolny panel, a w nim podgląd uchwytów. W tym celu możesz 

użyd skrótu Ctrl+H lub w głównym menu wybrad: 

View > Lower Pane View > Handles 



 

Dolny panel jest podzielony na dwie kolumny: Type oraz Name. Przewio zawartośd panelu aż w kolumnie 

Type ujrzysz typ Mutant: 

 

Zaznacz uchwyt o poniższej nazwie: 



\Sessions\1\BaseNamedObjects\VghdMutex 

Kliknij na nim prawym przyciskiem myszy i zamknij ten uchwyt wybierając polecenie Close Handle. 

 

Pojawi się okno z pytaniem czy na pewno chcesz wykonad tą czynnośd. Potwierdź klikając przycisk Tak (Yes). 

 

Wykonaj ten sam krok z następnym uchwytem: 

\Sessions\1\BaseNamedObjects\QtLockedFile mutex c:/jakas_sciezka/qtsingleapp-vghd-eafe-1-lockfile 

Zaznacz go, kliknij prawym przyciskiem myszy, zamknij uchwyt poleceniem Close Handle i potwierdź. 

Spróbuj teraz uruchomid drugą instancję (kopię) programu iStripper. Zauważysz, że po zamknięciu dwóch 

uchwytów uruchomiona zastała kopia programu iStripper (zwród uwagę na drugą ikonkę iStripper w pasku 

systemowym). W porządku, o to chodziło. 



Spróbujmy teraz uruchomid trzecią kopię iStripper. Aby to zrobid należy uprzednio zamknąd te same 

uchwyty dla ostatnio otwartego procesu vghd.exe. Odnajdź więc na liście procesów ostatnio uruchomiony 

proces vghd.exe. W tym momencie na liście procesów widnieją dwa procesy o takiej samej nazwie. Jeśli nie 

jesteś pewien który z nich został otwarty jako ostatni, możesz sprawdzid godzinę uruchomienia każdego 

z procesów vghd.exe. W tym celu kliknij na każdym z procesów prawym przyciskiem myszy i wybierz 

polecenie Properties... 

 

Godzina uruchomienia procesu znajduje się w miejscu zaznaczonym na obrazku: 

 



Wyłącz okno właściwości i zamknij te same dwa uchwyty, które zamknąłeś dla poprzedniego procesu 

vghd.exe, a więc: w dolnym panelu odnajdź typy Mutant, znajdź dwa poniższe uchwyty: 

\Sessions\1\BaseNamedObjects\VghdMutex 

\Sessions\1\BaseNamedObjects\QtLockedFile mutex c:/jakas_sciezka/qtsingleapp-vghd-eafe-1-lockfile 

kliknij na każdy z nich prawym przyciskiem myszy, wybierz Close Handle i potwierdź. Gotowe. Możesz teraz 

uruchomid trzecią instancję (kopię) programu iStripper. A co jeśli zapragniesz uruchomid czwartą kopię? 

Ależ proszę, wystarczy ponownie zamknąd te same dwa uchwyty dla ostatnio uruchomionego 

procesu vghd.exe. 

 

UWAGA: nie przesadzaj z liczbą uruchamianych kopii. Zbyt duża liczba uruchomionych iStripperów może 

spowodowad, że twój komputer znacznie zwolni. 

Obsługa programu iStripper 

Każdy dodatkowy duplikat procesu vghd.exe pozwolił ci na wyświetlenie dodatkowej jednej modelki 

w trybie powiększonym lub nawet dziesięciu modelek w trybie pomniejszonym. Dzięki osobnemu 

interfejsowi (GUI) możesz kontrolowad każdą z nich osobno. Aktywuj wszystkie kopie iStripper i pobaw się 

ustawieniami w każdym z GUI. Możesz ustawid inne opcje w każdej kopii programu. Po zamknięciu 

wszystkich kopii programu iStripper zapamiętywane są tylko ostatnio wybrane ustawienia. 

 



W przypadku wielu monitorów, aby wyświetlid po jednej modelce na każdym z nich: kliknij na wybranej 

modelce by przełączyd ją do rozmiaru pomniejszonego, przeciągnij ją na wybrany monitor i upuśd, kliknij na 

niej ponownie by przełączyd do trybu powiększonego. 

Zalety: 

 możesz wyświetlid dodatkowych dziesięd modelek w trybie pomniejszonym dla każdej 

uruchomionej kopii programu iStripper (UWAGA: takie ustawienie może znacznie spowolnid twój 

komputer!), 

 możesz wyświetlid tyle modelek w trybie powiększonym, ile uruchomionych jest kopii programu 

iStripper, 

 jeśli posiadasz dwa lub więcej ekranów, możesz wyświetlid po jednej modelce w trybie 

powiększonym na każdym z nich, 

 dla każdej modelki wyświetlanej w trybie powiększonym możesz używad osobnych ustawieo (np. 

inna skala dla każdej z dziewczyn). 

Wady: 

 nie możesz zmieniad pozycji klipów w trybie powiększonym przez przeciąganie i upuszczanie 

(drag'n'drop), 

 nie możesz zapisywad osobnych ustawieo dla każdej kopii programu iStripper. 

 

  



Edycja zawartości pamięci RAM - metoda 

z użyciem Cheat Engine 

Metoda polega na zmianie skali modelek poprzez edycję wartości bezpośrednio w pamięci operacyjnej 

RAM. W tej metodzie wystarczy uruchomienie tylko jednej kopii programu iStripper. 

Do edycji wartości zapisanych w pamięci RAM wykorzystamy program Cheat Engine. Jest to darmowe 

narzędzie zaprojektowane z myślą o możliwości modyfikowania gier jednoosobowych, ponadto pozwala też 

na debugowanie aplikacji jak również na inspekcję i zmianę zawartości pamięci. W tej metodzie 

wykorzystana zostanie ostatnia z wymienionych funkcji. 

Podziękowania dla użytkowników MrEff oraz Wyldanimal za podrzucenie pomysłu z wykorzystaniem 

programu Cheat Engine. 

INFORMACJA: Istnieje wersja programu Cheat Engine przeznaczona dla komputerów MAC. W związku 

z tym metoda ta powinna zadziaład również na komputerach MAC. Pewności nie mam, nie sprawdzałem. 

Pobieranie programu Cheat Engine 

Aby pobrad program Cheat Engine otwórz dowolną przeglądarkę i przejdź pod adres: 

http://www.cheatengine.org 

Pobierz program instalacyjny klikając duży przycisk z napisem "Download Cheat Engine" (trudny 

do przeoczenia). 

 



Zapisz instalator (plik CheatEngine67.exe) w dowolnym miejscu na dysku twojego komputera. 

UWAGA: Jeśli twój program antywirusowy uzna plik za złośliwy, nie przejmuj się tym. Pozwól mimo to na 

pobranie pliku. W razie konieczności tymczasowo deaktywuj swój program antywirusowy. 

Instalacja programu Cheat Engine 

Przejdź do folderu, do którego pobrałeś plik CheatEngine67.exe i uruchom instalator klikając go 

dwukrotnie. Niektóre programy antywirusowe przez pomyłkę uznają program Cheat Engine za wirus lub 

trojan, blokując możliwośd instalacji. Jeśli w twoim przypadku instalator nie uruchamia się, wyłącz 

tymczasowo ochronę antywirusową lub zamknij program antywirusowy na czas instalacji. 

Instalator przywita cię ekranem powitalnym. Kliknij przycisk Next. 

 

Wyraź zgodę na postanowienia licencyjne i kliknij przycisk Next. 



 

Wskaż ścieżkę do folderu, w którym zostanie zainstalowany program Cheat Engine. Zaleca się 

pozostawienie domyślnej ścieżki. Kliknij przycisk Next. 

 

Na kolejnym ekranie instalator poinformuje o utworzeniu skrótów w menu Start. Możesz zaznaczyd opcję 

"Don't create a Start Menu folder" jeśli nie chcesz by instalator tworzył skróty. Kliknij przycisk Next. 



 

Instalator będzie chciał utworzyd skrót do programu Cheat Engine na pulpicie twojego komputera. Zgódź się 

na to aby mied łatwy dostęp do programu. W razie potrzeby będziesz mógł usunąd skrót ręcznie. Jeśli 

chcesz aby program Cheat Engine szukał aktualizacji, zaznacz opcję "Check for new versions when starts". 

Kliknij przycisk Next. 

 



UWAGA: w kolejnym kroku instalator zapyta czy chcesz zainstalowad dodatkowe oprogramowanie firm 

trzecich. Nie zgadzaj się na to. Odhacz wszystkie zgody i przejdź dalej klikając przycisk Next. 

 

Przed zainstalowaniem programu instalator wyświetli podsumowanie. Przejrzyj je na wszelki wypadek. Jeśli 

uważasz, że wszystkie ustawienia są właściwe, kliknij przycisk Install. 

 



Po zainstalowaniu wszystkich składników programu instalator wyświetli dodatkową informację, którą 

możesz przeczytad (ale nie musisz). Kliknij przycisk Next. 

 

Instalacja została zakooczona. Zostaw zaznaczone opcje "Reset settings" oraz "Launch Cheat Engine" i kliknij 

przycisk Finish. 

 



Przy pierwszym uruchomieniu program zasugeruje skorzystanie z poradnika. Na razie jest on zbędny, 

dlatego kliknij przycisk Nie (No). 

 

Program Cheat Engine uruchomi się i będzie gotowy do pracy. Tak wygląda jego główne okno: 

 

Obsługa programu Cheat Engine 

Jeśli iStripper jest wyłączony, włącz go teraz. W programie Cheat Engine kliknij ikonkę z komputerem, wokół 

której pulsuje czerwono-zielona ramka. Możesz także użyd polecenia w głównym menu: 



File > Open Process 

 

W otwartym małym okienku przejdź do zakładki Processes. Na liście procesów odnajdź vghd.exe, zaznacz, 

poczym kliknij przycisk Open. 

 



Program jest gotów do skanowania pamięci używanej przez wybrany proces. Aby przeskanowad pamięd 

RAM musisz mniej-więcej wiedzied czego szukad. W tym przypadku skupiamy się na wielkości klipów 

wyświetlanych przez iStripper. W związku z tym spróbujmy przeskanowad pamięd w poszukiwaniu skali, 

jaka aktualnie jest ustawiona dla modelek w trybie pomniejszonym. Otwórz program iStripper i przejdź do 

ustawieo. Ustaw dowolną skalę dla trybu pomniejszonego (Small size), np. 25%. Zapamiętaj liczbę 25. 

 

Wród do programu Cheat Engine i wpisz zapamiętaną liczbę w polu Value, poczym kliknij przycisk 

First Scan. 

 

Program odnajdzie kilkanaście, kilkadziesiąt lub nawet kilka tysięcy adresów zawierających podaną wartośd. 



 

To zbyt dużo by ręcznie szukad interesującej nas wartości, w związku z tym przefiltrujemy wyniki. Przejdź 

raz jeszcze do ustawieo iStripper i tym razem ustaw skalę modelek (w trybie pomniejszonym) np. na 15%. 

Zapamiętaj liczbę 15. 

 

Wród do programu Cheat Engine i wpisz zapamiętaną liczbę w polu Value. Tym razem kliknij przycisk 

Next Scan. 



 

Tym razem program odnalazł trzy adresy zawierające wyszukiwaną wartośd. Właśnie o te trzy adresy nam 

chodziło. Teraz pomyśl: jak duże modelki chciałbyś oglądad na ekranie swojego monitora? 80 procent? Sto, 

a może jeszcze więcej procent? Na początek przyjmijmy 85%. W programie Cheat Engine zaznacz pierwszy z 

trzech odnalezionych adresów, kliknij na nim prawym przyciskiem myszy i wybierz polecenie Change value 

of selected addresses lub użyj skrótu Ctrl+E. 



 

W nowym małym okienku podaj nową wartośd, jaką chcesz użyd. W tym przypadku będzie to 85. Wpisz ją 

i zatwierdź klikając przycisk OK. 

 

Wykonaj te same czynności dla dwóch pozostałych adresów zmieniając wszystkie wartości na 85. 



 

Gotowe. Aktywuj teraz iStripper i wyświetl pokaz w trybie pomniejszonym aby ujrzed rezultat. Dla lepszego 

efektu ustaw liczbę modelek na 3-5. 

Obsługa programu iStripper 

Dzięki tej metodzie jesteś w stanie wyświetlid jednocześnie do 10 modelek w skali większej niż 60% (na tyle 

pozwala iStripper w trybie pomniejszonym). Niestety sterowanie skalą za pomocą interfejsu programu 

iStripper staje się niemożliwe. Ponowne użycie suwaka w programie iStripper nadpisze pamięd 

i wprowadzone za pomocą Cheat Engine wartości trzeba będzie ustawid jeszcze raz. Ponadto wprowadzone 

zmiany nie będą miały wpływu na aktualnie odtwarzane klipy. Zostaną one zastosowane dopiero do 

kolejnego klipu. Zamknięcie programu iStripper i jego ponowne uruchomienie również sprawi, że 

wprowadzone przez nas modyfikacje będą musiały zostad powtórzone. 



 

Zalety:  

 w trybie pomniejszonym możesz wyświetlid jednocześnie do dziesięciu modelek w skali większej 

niż 60%, 

 możesz swobodnie zmieniad pozycję klipów przez przeciąganie i upuszczanie (drag'n'drop), dzięki 

czemu możliwe jest rozmieszczanie modelek na kilku monitorach, 

 możesz oglądad klipy pośrednie (eng. transition clips) w pełnej skali. 

Wady: 

 nie możesz stosowad osobnych ustawieo dla poszczególnych modelek, 

 nie możesz zapamiętywad wprowadzonych ręcznie ustawieo. 

 

  



Linki 

Plik został pobrany ze strony: http://www.isworkshop.eu 

lub: http://lukasr.net/projects/istripper 

Ogólna dyskusja: http://www.istripper.com/forum/thread/39125/1 

 

http://www.isworkshop.eu/
http://lukasr.net/projects/istripper
http://www.istripper.com/forum/thread/39125/1

